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Patents 

The technique of using a wall-mounted scanner to capture a 

photographic side profile of a human face, which is then used to 

create a 3D relief in ArtCAM, is subject to a patent. 

Patent No: GB 2 387 731 "Deriving a model from a scan of an 

object" 

The functionality of preparing a 3D relief of the side profile of a 

human face direct from a photograph in ArtCAM is subject to a 

patent. 

Patent No: GB 2 403 883 "Photo to 3D" 

The functionality of the 3D layers used to design and machine an 

article in ArtCAM is subject to a patent application. 

Patent No: GB 2 434 287 "3D Layers" 

The functionality of creating a low relief from an imported 3D object 

in ArtCAM without losing low-level detail is subject to a patent. 

Patent No: GB 2 455 966 "Method and System for Generating 
Low Reliefs – a.k.a. Scan to Low Relief" 

The functionality of filling an area with geometric or natural textures 
using pattern elements and a controlling direction line in ArtCAM is 

subject to a patent application. 

Patent Application: GB 2492225 "Texture Flow" 

The Support structure functionality is subject to patent applications. 

Patent application: US 14325878 Method for calculating support 
structures and support elements for attaching a support strut of 

same 

Patent application: GER 10 2013 011 630.9 Method for 
calculating support structures and support elements for attaching 

a support strut of same 
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ArtCAM 2015 offers all the original features of ArtCAM 2013, but 

with numerous improvements. This document describes the most 

significant improvements.  

Visit the website at http://www.artcam.com/ for the latest news and 

videos. 
 

What's New in ArtCAM 
2015 
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Summary of new features 
ArtCAM 2015 contains the following new features and 

enhancements: 

Designing 

 Sculpting with the Putty tool (see page 6) — There is a new Putty 

tool available from the sculpting tools section of the Design Tools 

toolbar. This tool enables you to displace, whirl, pinch, and 

pucker selected relief clipart or vectors. 

 Live modelling tools (see page 12) — Several tools now provide you 

with instant results when you use them. 

 Creating vector text (see page 22) — The Text tool is updated and 

can be fully used in the 3D View window. It also now includes the 

Text on a Curve tool. 

 Selecting vectors with the Vector Doctor (see page 27) — The 

Vector Doctor panel includes two new buttons for selecting 

vectors. 

 Editing nodes (see page 28) — The node editor is improved so 

you can select nodes from multiple vectors. 

 Pasting vectors (see page 29) — When pasting vectors, you can 

now choose to preserve the vector layers. 

 Exporting vectors (see page 31) — You can now export vectors as 

.svg (scalable vector graphic) files. 

 Filleting Vectors (see page 31) — The Fillet Vectors tool now 

works in the 3D View window. 

 Combining reliefs (see page 32) — There is now a Replace option 

on Relief Layer panels, the Clipart panel, and some Tool Settings 

panels, which provides you with a new way to combine reliefs 
and relief layers. 

 Sending relief clipart to the Relief Clipart Library (see page 34) — 

There is a new Send to Relief Clipart Library button on the Clipart 

panel, which provides you with a faster way to send relief clipart 
to the Relief Clipart Library. 

 Creating rotary models (see page 35) — There is a new option on 

the File > New menu, which enables you to create a new rotary 

model. 

 Slicing reliefs (see page 36) — The Slice Relief panel is updated, 

and you can now select how you want to output the slices. 

 Nudging objects (see page 39) — There is now a Nudge Distance 

dialog which enables you to specify a fixed distance by which 

objects move when you press the arrow keys. 
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 Box-selecting objects (see page 40) — The direction from which 

you box-select objects controls how the objects are selected. 

 Selecting multiple items in the Project Tree (see page 41) — You 

can now select multiple items in the Project Tree simultaneously. 

Machining 

 Updating bridges (see page 48) — There is a new Update All 
button on the Create Bridges panel, and on the toolpath panels 

which contain bridge sections. 

 Importing .dxf files with the 2D Machining Wizard (see page 48) — 

You can select the units used when you import a .dxf file. 

 Creating form tools (see page 43) — You can create your own 
custom form tools from vectors and save them in the Tool 

Database. 

 2D toolpath shading (see page 50) — If you are an ArtCAM Express 

customer and have the Advanced 2D Machining module, you can 

now preview toolpaths in the 2D View window. 

 Defining material dimensions in Express and Insignia (see page 52) 

— In ArtCAM Express and ArtCAM Insignia, the Setup New Model 
dialog is replaced by the Size For New Model dialog to bring them 

in line with ArtCAM Pro and ArtCAM Jewelsmith. 

User interface changes 

 Transform panel (see page 53) — There is an additional way to 
switch between the two Transform panel pages. 

 Set Model Size dialog (see page 54) — The Height In Z field in the 
Set Model Size dialog now defaults to 0. 

 Defining material dimensions in Express and Insignia (see page 52) 

— The Setup Job Dimensions dialog is replaced by the Size For 

New Model dialog in Express and Insignia to bring the workflow in 

line with Pro and Jewelsmith.  

 Resetting reliefs (see page 54) — The Zero and Zero Rest options, 

which were previously located on the Shape Editor panel, are now 

called Zero Inside Vector and Zero Outside Vector, and are found 

on the Relief Editing toolbar. 

 The following panels have a new layout: 

 Tool Settings: Text Tool panel (see page 22). 

 Tool Settings: Two Rail Sweep panel (see page 15). 

 2D Machining Wizard (see page 48). 

 Miscellaneous interface changes (see page 55) — These options 

have the same behaviour, but a new name or location. 
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General enhancements 

 Importing STL files (see page 59) — By default, ArtCAM now 

identifies and removes duplicate faces when you import STL files. 

 New Express modules (see page 60) — There are four new 

modules available for ArtCAM Express customers: Bevel Carving, 

Fluting, Multi-plate engraving, and Panelling. 

 New Insignia tools (see page 61) — Several tools that were 

previously available only for Pro and Jewelsmith users are now 

available for Insignia users. 

 Licencing information (see page 62) — The type of licence you 

hold is now displayed in the product banner. 
 



 

ArtCAM 2015 What's New What's New in ArtCAM 2015 • 5  

Designing 
This section describes enhancements made to the design and 

editing process in ArtCAM. 

 Sculpting with the Putty tool (see page 6) — There is a new Putty 

tool available from the sculpting tools section of the Design Tools 

toolbar. This tool enables you to displace, whirl, pinch, and 

pucker selected relief clipart or vectors. 

 Live modelling tools (see page 12) — Several tools now provide you 

with instant results when you use them. 

 Creating vector text (see page 22) — The Text tool is updated and 

can be fully used in the 3D View window. It also now includes the 

Text on a Curve tool. 

 Selecting vectors with the Vector Doctor (see page 27) — The 

Vector Doctor panel includes two new buttons for selecting 

vectors. 

 Editing nodes (see page 28) — The node editor is improved so 

you can select nodes from multiple vectors. 

 Pasting vectors (see page 29) — When pasting vectors, you can 

now choose to preserve the vector layers. 

 Exporting vectors (see page 31) — You can now export vectors as 

.svg (scalable vector graphic) files. 

 Filleting Vectors (see page 31) — The Fillet Vectors tool now 

works in the 3D View window. 

 Combining reliefs (see page 32) — There is now a Replace option 

on Relief Layer panels, the Clipart panel, and some Tool Settings 

panels, which provides you with a new way to combine reliefs 

and relief layers. 

 Sending relief clipart to the Relief Clipart Library (see page 34) — 

There is a new Send to Relief Clipart Library button on the Clipart 

panel, which provides you with a faster way to send relief clipart 

to the Relief Clipart Library. 

 Creating rotary models (see page 35) — There is a new option on 

the File > New menu, which enables you to create a new rotary 

model. 

 Slicing reliefs (see page 36) — The Slice Relief panel is updated, 

and you can now select how you want to output the slices. 

 Nudging objects (see page 39) — There is now a Nudge Distance 

dialog which enables you to specify a fixed distance by which 

objects move when you press the arrow keys. 
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 Box-selecting objects (see page 40) — The direction from which 

you box-select objects controls how the objects are selected. 

 Selecting multiple items in the Project Tree (see page 41) — You 

can now select multiple items in the Project Tree simultaneously. 
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Sculpting with the Putty tool 

 ArtCAM Pro and ArtCAM Jewelsmith only. 

The new Putty tool enables you to either subtly alter parts of your 

model or completely change the entire piece by displacing, whirling, 

pinching, puckering, ridging, or rucking selected relief clipart or 

vectors. It can be beneficial for people who make plasters because 
you can scan in plasters and manipulate them with minimal loss of 

detail. It can also be useful for people who need to make minor 

adjustments to reliefs, such as mints and engravers, who might, for 

example, need to reduce the size of a particular feature without 
altering the surrounding areas. 

The Putty  button is located with the sculpting tools on the 

Design Tools toolbar. When you click Putty , the Tool Settings: 

Putty Tool panel is displayed.  

 



 

8 • What's New in ArtCAM 2015 ArtCAM 2015 What's New  

 The Putty tool is available only when you have vectors or 

clipart selected. 

The following settings are available: 

Action — Select the type of brush you want to use. 

 Displace — Select this option to move the material around 

the modelling area. 

For example, you could increase the size of this octopus's head: 

Before After 

  

 

  Anticlockwise/Clockwise Whirl — Select one of these 

options to twist the model anticlockwise or clockwise about the 

centre of the tool. 

For example, you could add waves to this spikey shape to give it an 

underwater feel: 

Before After 
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 Pinch — Select this option to decrease the size of the 

model within the area of the tool radius. 

For example, you could shrink this mask's nose: 

Before After 

  

 

 Pucker — Select this option to increase the area of the 

model from the centre of the tool radius to the edge of the tool 
radius. 

For example, you could increase the size of this bear: 

Before After 

  

 

 Ridge — Select this option to create a sharp line along the 

line you sculpt.  

For example, you could define features and sharpen edges after 

distorting a piece of clipart using other Putty tools. In this example, 
the deer relief has been smoothed, then the features have been 

redefined using the Ridge tool. 

Before After 
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 Ruck — Select this option to create a plateau the width of 

the brush at the height of the surrounding clipart.  

For example, you could artistically clear an area before adding text. 

Before  After 
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Tool — Use the Tool area to define the parameters of the putty tool.  

Shape — Select a brush shape from the list. To use a circular 

brush, select Round. To use a brush that is the shape of the relief 

on the active relief layer, select Relief Layer. 

Radius — Drag the slider to define the radius of the tool. This 

setting determines the area of the object that is affected by each 

mouse movement. The size is shown in pixels and units. 

Strength — Drag the slider to define the pressure of the tool. This 

setting determines the strength of the affect of the tool on the 
object. The greater the strength, the greater the affect of the 

tool on the object.  

 When using the Displace brush, setting a strength of 100% 

enables the cursor to most closely track the changes to the 
selection.  

Smoothness — Drag the slider to define the sharpness of the 

tool. This setting determines the smoothness of the blend 

between the material under the tool and the surrounding object. 

The higher the smoothness, the softer the blend. 

Behaviour 

Scatter Distance — Select this option to apply the tool's effect to 
the selected object at random intervals. In the Scatter Distance 

field, specify the maximum distance from the sculpting cursor at 

which the putty action can be applied. 

Sculpting Session — Use the Sculpting Session area to create a 

restore point or undo all sculpting since the last restore point. 

Revert — Click Revert to restore an object to its original state, or 

to the last restore point, if one was created. 

Snapshot — Click Snapshot to create a restore point in your 

current sculpting session. 

 You can use the Undo and Redo buttons on the File toolbar to 

undo and redo step by step. This is useful for undoing minor 

mistakes. 
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Display Settings — Click the control bar to show the Display Settings 

options. 

Grid — Select this option to toggle on grid lines in the model 

area. The grid lines distort with the object as you use the Putty 

tool, enabling you to see how much an object has been modified 
from the original.  

Boundary — Select this option to toggle on the display of the 

boundary which is drawn around the sculpting area. You cannot 

sculpt past the boundary even if it is not visible. 

 If you try to move an object past this boundary, the object 
is squashed up against it. 
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Live modelling tools 

Several modelling tools are improved so that you now receive 

instant feedback while you work with them. This real-time feedback 

gives you fine control over relief creation and enables you to be 

more creative because you can play with a model, tweaking it until 
it looks right, rather than having to undo, then repeat steps, until 

the desired result is achieved. 

The following tools are now live: 

 Shape Editor (see page 13) 

 Two Rail Sweep (see page 15) 

 Extrude (see page 17) 

 Spin (see page 19) 

 Turn (see page 21) 
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Changes to the Shape Editor tool 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

In ArtCAM 2015, the Shape Editor has undergone several changes to 

improve usability. 

 When you open the Shape Editor, it opens as a Tool Settings 

panel, rather than as a floating dialog.  

 

 The Zero and Zero Rest buttons (see page 54) are renamed to 

Zero Inside Vector and Zero Outside Vector are now located on the 

Relief Editing toolbar. 
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 The shape calculation is much faster than in previous versions, 

even in large models. 

 The reliefs are calculated in real time, so you get instant 

feedback while you use the tool. 

 You can edit nodes in the relief boundary and the relief updates 
as you edit. 

 You can instantly see the effect of any changes on the relief 

stack.  
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Two Rail Sweep 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

The Two Rail Sweep tool now works live, so instead of pressing 

calculate and waiting for the results, you can select different vectors 
or edit nodes and ArtCAM immediately recalculates the relief. The 

tool also opens as a Tool Settings panel, and is tabbed with the 
Project panel.  

ArtCAM 2013 ArtCAM 2015 

 

 

In addition: 

 The marker points on the drive rails that denote where the cross 

sections are placed can now be dragged into position using the 

cursor. 
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 Top Drive Rail is renamed to Set First Drive Rail. 

 Bottom Drive Rail is renamed to Set Second Drive Rail. 

 The Reverse Direction of Drive Rails options are replaced by the 

Reverse Direction  buttons. 

 Z Control Vector is renamed to Set Z Mod Profile, and is now in the 

Height Controls area. 

 There is a Replace (see page 32) option in the Relief Combine 

Mode area. 

 The Reset, Calculate, and Close buttons are replaced by Apply 

and Cancel. 

 You must click Apply before closing the panel or the relief is 

reset. 
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Extrude 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

The Extrude tool now works live, so instead of pressing calculate 

and waiting for the results, you can select different vectors or edit 
nodes and ArtCAM immediately recalculates the relief. The tool also 
opens as a Tool Settings panel, and is tabbed with the Project panel. 

ArtCAM 2013 ArtCAM 2015 

 

 

In addition: 

 The Drive Curve area is now the Drive Rails area. 

 In the Drive Rails area, Reverse Direction  replaces the 

Reverse curve direction option. 

 In the Start Profile area, Reverse Direction  replaces the Move 

anchor point to other end option. 

 There is a new Replace (see page 32) option in the Combine 

Mode area. 
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 The Calculate and Reset buttons are replaced by Apply and 

Cancel.  

 You must click Apply before closing the panel or the relief is 

reset.  
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Spin 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

The Spin tool now works live, so instead of pressing calculate and 

waiting for the results, you can select different vectors or edit nodes 
and ArtCAM immediately recalculates the relief. The tool also opens 
as a Tool Settings panel, and is tabbed with the Project panel. 

ArtCAM 2013 ArtCAM 2015 

 

 

In addition: 

 In the Start Profile area, Reverse Curve  replaces the Move 

anchor point to other end option. 

 In the Sweep area, the Start angle field, Clockwise option, and 

Anticlockwise option are hidden unless Sweep 360 degrees is 

deselected. 

 There is a new Replace (see page 32) option in the Combine 

Mode area. 

 The Calculate and Reset buttons are replaced by Apply and 

Cancel.  

 You must click Apply before closing the panel or the relief is 

reset.  
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Turn 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

The Turn tool now works live, so instead of pressing calculate and 

waiting for the results, you can select different vectors or edit nodes 
and ArtCAM immediately recalculates the relief. The tool also opens 
as a Tool Settings panel, and is tabbed with the Project panel. 

ArtCAM 2013 ArtCAM 2015 

 

 

In addition: 

 There is no Select button. The vector is selected automatically 

with the cursor. 

 Combine Mode is now called Relief Combine Mode. 

 There is a new Replace (see page 32) option in the Relief 

Combine Mode area. 

 The Calculate and Reset buttons are replaced by Apply and 

Cancel.  

 You must click Apply before closing the panel or the relief is 

reset.  
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Creating vector text 

In ArtCAM 2015 there are improvements to the performance and 

layout of the Text Tool to make it easier for you to create and edit 
vector text. In addition, the settings from the Tool Settings: Text On 

A Curve panel are now included on the Text Tool panel, which 

means that all vector text creation settings are accessible from the 

same tool. 

To display the Tool Settings: Text Tool panel, click Create Vector Text 

 on the Design Tools toolbar.  
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Layout 

The Tool Settings: Text Tool panel has a new layout, and some 

options have been renamed or modified. 

 In the Transform area: 

 Graphics have been added to illustrate the options. 

 Resize is now Scale width and Scale height. 

 Angle is now Shear width. 

 The Kerning area has been combined with the Spacing area, and 

you are no longer able to manually alter the kerning using the 
Tool Settings: Text Tool panel. If you would like to manually edit 

the kerning, you must use the Font Editor module. 

 The options that were previously on the Tool Settings: Text on a 

Curve panel are now at the bottom of the Tool Settings: Text Tool 

panel. 

 

Performance 

The Text Tool includes the following improvements to performance: 

 You can create and edit all vector text in the 3D View window.  

 Text is fully transformable and the bounding box that surrounds 
the text behaves the same as the Transform Tool transform box. 

This enables you to rotate, scale, and angle the text using the 
cursor while in Text Tool mode. 
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 You can now either select the curve and then create and edit the 

text, or create the text and then, while still in Text Tool mode, 
select the curve. Previously, in order to wrap text on a curve, 

both the text and the curve had to exist.  

 When wrapping text to a curve, a dark blue anchor point 
indicates the origin of the text. The direction in which the text 

expands from the anchor point is controlled by the alignment 

mode. For example, if you select a centre alignment, text 

expands in both directions from the anchor point. Change the 

position of the control point by clicking and dragging it along the 

curve, either before or after you type the text.  

 

 You can now click and drag to select characters that are wrapped 

to a curve, which means you can edit sections of text 
simultaneously. 

 



 

ArtCAM 2015 What's New What's New in ArtCAM 2015 • 25  

 When text is wrapped to a curve, press and hold down the Ctrl 

key while dragging to increase or decrease the space between 

two characters.  

 

 If text exceeds the length of the curve, the text continues along 

the tangent of the curve.  
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 You can now wrap multiple lines of text along a curve. Press 
Enter while typing to start a new line of text that is wrapped to 

the same curve. 
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Selecting vectors with the Vector Doctor 

There are two new buttons on the Vector Doctor panel, which give 

you more control when selecting vectors. 

 

 Click Clockwise to select closed vectors with a clockwise 

direction. 

 Click Anticlockwise to select closed vectors with an anticlockwise 

direction. 
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These options are also available from: 

 the Edit > Select All menu on the Main Menu bar. 

 

 the context menu, which is displayed when you right-click in the 
View window. 
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Editing nodes 

In ArtCAM 2015, you can now select multiple vectors when you are 
in Node Editor mode. This means you can select and edit the nodes 

of several different vectors simultaneously. Previously, you could 

select only one vector at a time when editing nodes. 

In the following example, the nodes of six vector shapes are 

selected, and you only need to move one node to control them all. 
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Pasting vectors 

When you paste vectors, you can now choose to preserve the vector 

layers of your original selection. Previously, vectors would be pasted 

into the active vector layer and any colour attributes would be lost. 

The new Paste Preserving Layers option can be found in two 

locations: 

 The Edit menu on the Main Menu bar. 

 

 The context menu that is displayed when you right-click in the 
View window. 
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Exporting vectors 

You can now export vector layers to .svg (Scalable Vector Graphic) 

files, which enables you to open the vector layers in paint type 

programs, such as Inkscape 

To export a vector layer as an .svg file: 

1 In the Project Tree, right-click the vector layer you want to 

export. 

 

2 Select Export. The Save Vector Layer dialog is displayed. 

3 Navigate to location in which you want to save the file. 

4 In the Save as type list, select SVG (*.svg). 

 

5 Enter a file name. 

6 Click Save. The vector layer is saved as an .svg file and the dialog 

is closed. 
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Filleting vectors in the 3D View window 

You can now use the Fillet Vectors  tool on vectors in the 3D 

View window. Previously this tool worked only in the 2D View 

window. 
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Combining reliefs 

There is a new Replace option available when you are combining a 

calculated relief with the active layer or with the relief layer stack. 
The Replace option replaces the current relief with any areas of the 

calculated relief that are greater than zero. Previously, a replace 
option was only available from the Relief Editing toolbar, and it 

worked in conjunction with shape attributes applied to the Colour 

Palette. 

The Replace option is available from: 

 the Relief Combine Mode area which is included in some Tool 

Settings panels.  

 

 the Paste mode list on the Clipart panel that is displayed below 
the splitter bar when you select the Clipart item from the Project 

Tree. 
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 the Combine mode list on the Relief Layer panel that is displayed 

below the splitter bar when you select a relief layer from the 

Project Tree. (ArtCAM Insignia, ArtCAM Pro, and ArtCAM 

JewelSmith only) 

 

In the Tool Settings panels and Clipart panel, the combine modes 

control how the relief combines with the active layer. In the Relief 

Layer panel, the combine mode controls how the active layer 

combines with the relief layer stack. (ArtCAM Pro, and ArtCAM 

JewelSmith only) 
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Sending relief clipart to the Relief Clipart Library 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

You can now send relief clipart to the Relief Clipart Library using the 

new Send to Relief Clipart Library  button on the Clipart panel. 

This is useful if, for example, you have created relief clipart using 
the Relief Cookie Cutter tool. Previously you had to paste the 

cookie-cut relief clipart into a relief layer and then send the relief 

layer to the Relief Clipart Library. 

 

To send relief clipart to the Relief Clipart Library: 

1 In the Relief Clipart Library panel, choose the library to which you 

want to add the relief clipart. 

2 In the 3D View window, select one or more pieces of relief 

clipart. 

3 In the Project Tree, click the Clipart item to display the Clipart 

panel. 

4 In the Clipart panel, click Send to Relief Clipart Library . 

Each piece of relief clipart selected is added as a separate item to 
the library. 
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Creating rotary models 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

You can create blank rotary models in ArtCAM Insignia, ArtCAM Pro, 
and ArtCAM Jewelsmith with the Size for New Rotary Model dialog.  

To display the Size for New Rotary Model dialog, click File > New > 

Rotary Model. This dialog enables you to create a rotary model, and 

choose whether the model wraps around the X or Y axis.  

When you have created a rotary model, the Front Relief and Back 

Relief icons in the Project Tree change from  to . 

 In ArtCAM Insignia the Relief icon changes from  to . 

 

To create a rotary model: 

1 On the Main Menu bar, click File > New > Rotary Model. 

2 In the Cylinder Dimensions area: 

a Enter the Diameter of the cylinder. 

b Enter the Length of the cylinder. 

3 In the Wrapping area, select whether you want to wrap the 

model around the X axis or Y axis. 

4 In the Units area, Select the units you want to work in. 

5 In the Resolution area, use the slider to set the resolution for the 

model. 

6 Click OK to create a new rotary model. 

 The 3D View window appears empty until you create a relief. 
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Slicing reliefs 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

The Slice Relief tool is now available for Insignia users. You can use 

this tool to divide the composite relief or the content of a single 

layer into slices.  

 

There are improvements to the tool and the layout of the panel: 

 Slices can be exported to .svg, .png, or .rlf files. Previously, slices 

could only be created as relief layers. 

 There is a new Number of layers field, which means you can enter 

the number of slices you want to create. 
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To display the Slice Relief panel, click Slice Relief  on the Relief 

Editing toolbar. 

 

The following settings are available: 

Selection Method 

Selected Layer — Select to create slices from the relief on the 

selected layer. 

Composite Relief — Select to create slices from the composite relief. 

Slices 

Slice thickness — Enter the maximum thickness you want for each 

slice. The Number of slices field is automatically updated to display 

the number of slices this thickness creates. 

Number of slices — Enter the number of slices you want to create. 

The Slice thickness field is automatically updated to display the 

maximum thickness of the slices. 

Relief min, Relief max, Total height — This area displays the 

properties of either the composite relief or currently selected layer, 
depending on which option is selected in the Selection Method area. 

Output 

Slice to — Select which format you want to export the slices to: 
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 ArtCAM Relief Layers — Select to create each slice on a separate 

relief layer. This option is available only for ArtCAM Pro and 

ArtCAM JewelSmith. 

 ArtCAM RLF files — Select to export each slice to a separate .rlf 

file. Each file is called slice and is numbered incrementally. 

 SVG file — Select to export the slices to an .svg file.  

 PNG — Select to export each slice to a separate .png file. Each 

file is called slice and is numbered incrementally. 

Select Destination — Browse to the location in which you want to 

save the slices. This field is displayed only if you select ArtCAM RLF 

files, SVG file, or PNG from the Slice to list. 

Smoothness — Enter a percentage to control how smooth the vector 

tracing is. Increasing the value creates higher detail curves, but can 

also round the edges of cornered shapes. This field is available only 
if you select SVG file from the Slice to list. 

Apply — Click to create the slices.  
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Nudging objects 

In ArtCAM 2015, you can now define a fixed distance of movement 
using the new Nudge Distance dialog. In ArtCAM 2013, you could 

use the arrow keys to move, or nudge, selected objects around the 

workspace, but the distance of each individual movement was set 
according to the zoom level.  

 

Use fixed nudge distance — When selected, the object moves by the 

distance specified in the Distance field every time you press an 

arrow key, even if you select another object. When deselected, you 

return to the traditional zoom based nudging. 

Distance — Enter a value for the nudge distance. 

To use a fixed nudge distance: 

1 Select the object you want to nudge. 

2 Press Alt and any arrow key. This displays the Nudge Distance 

dialog. 

3 In the Distance field, enter the distance by which you want to 

nudge the object. 

4 Click OK, or press the Enter key. The dialog closes and the object 

moves in the direction of the arrow key by the distance specified. 
Every time you press an arrow key, the selected object moves by 
this distance.  

 The Use fixed nudge distance option is selected 

automatically when you enter a distance and click OK. 

Deselect the option or enter a distance of 0 to return to 

zoom based nudging. 

5 Click Cancel to close the dialog without nudging the object. 
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Box-selecting objects 

In ArtCAM 2015, when you select objects by dragging the mouse 

from right to left, all objects within and partially within the bounding 

box are selected. When you select objects by dragging the mouse 

from left to right, only those objects wholly within the boundary 
were selected.  

Box-selecting from right to left: 

 

Box-selecting from left to right: 
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Selecting multiple items in the Project Tree 

In ArtCAM 2015, there are some changes to the Project Tree to 

improve usability. 

Multiple selection — You can select multiple items of the same type 

at the same time.  

 Hold down the Ctrl key while clicking to select another item.  

 Hold down the Shift key while clicking to select all items in 

between.  

 Hold down the Shift key while pressing up or down arrows selects 

extra items. 

Moving items — When you have one or more items selected, hold 
down the Ctrl key and press the up or down arrow keys to move the 

selected items up or down in the list. 

Deleting items — Press the Delete key to delete selected items from 

the Project Tree. 

New panels — Some options are displayed below the splitter bar 
when you have multiple Vectors, Bitmaps, Reliefs, Sheets, or 
Toolpath items selected. 

New context menus — There are new context menus available when 
you have multiple Vectors, Bitmaps, Reliefs, Sheets, or Toolpath 

items selected. 
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Machining 
This section describes enhancements made to the machining 

process in ArtCAM. 

 Updating bridges (see page 48) — There is a new Update All 

button on the Create Bridges panel, and on the toolpath panels 

which contain bridge sections. 

 Importing .dxf files with the 2D Machining Wizard (see page 48) — 

You can select the units used when you import a .dxf file. 

 Creating form tools (see page 43) — You can create your own 
custom form tools from vectors and save them in the Tool 

Database. 

 2D toolpath shading (see page 50) — If you are an ArtCAM Express 

customer and have the Advanced 2D Machining module, you can 
now preview toolpaths in the 2D View window. 

 Defining material dimensions in Express and Insignia (see page 52) 

— In ArtCAM Express and ArtCAM Insignia, the Setup New Model 

dialog is replaced by the Size For New Model dialog to bring them 

in line with ArtCAM Pro and ArtCAM Jewelsmith. 
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Creating form tools 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

You can now create your own complex tools in the tool database to 

match those in your tool room. This enables you to simulate 

toolpaths more accurately, and can reduce simulation time because 

you no longer have to try to match a single tool with a combination 

of tools from the tool database. 

The new Create Custom Form Tool  button is located in the 

Toolpath Operations area of the Toolpaths panel.  

 

Before you click Create Custom Form Tool , you must first 

import or create an open vector to define the half-profile of the form 
tool. This vector is revolved to create the tool, and the diameter of 

the tool is taken from the widest point of the profile. The custom 

form tool cannot be scaled after it is created so you must ensure 
the vector exactly matches the dimensions of your tool. 
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When you click Create Custom Form Tool , the Edit Tool dialog 

is displayed. Use this dialog to set the parameters for your tool. 

 

Description — Enter a name for the tool. 

Tool Type — The category of tool is displayed. This cannot be 

changed when creating a custom tool. 

Tool Number — Specify the number of the tool to correspond with its 

position on a tool changer. 

Tool Units — Select the unit of measurement for the tool from the 

list. 

Rate Units — Select the unit of speed for the tool from the list. 

Notes — If you want to make any notes about the selected tool, 

enter them in this field. 

Diameter (D) — The diameter of the tool is set by the size of the 

vector. This cannot be changed when creating a custom tool. 

Stepdown — Enter the maximum cut depth of the selected tool. 

Final Tool Offset — The tool offset value is displayed. It is half the 

diameter and cannot be changed. 

Stepover (Size, % of D) — Enter a value in the first field ( ) to 

specify the distance between adjacent machining passes made by 

the selected tool. Enter a value in the second field ( ) to specify 
this distance as a percentage of the tool Diameter (D). 
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 Each click on  increases the stepover of the selected tool by 
1% of the value shown in the Diameter field. 

 Each click on  decreases the stepover of the selected tool by 
1% of the value shown in the Diameter field. 

Spindle Speed (rpm) — Enter the rotational speed of the spindle. 

Feed Rate (mm/sec) — Enter the rate at which the tool moves in 

relation to the material block. 

Plunge Rate (mm/sec) — Enter the rate at which the tool moves in 

the Z direction and plunges into the material block. 

 You must have an open vector selected before you click 
Create Custom Form Tool or an error message is displayed. 

Your custom form tool is added to the Tool Database and can 

subsequently be edited in the same way as the standard tools, 
except you cannot change the diameter. For more information, see 

the Using the Tool Database in the Reference Help. 

To create a custom tool: 

1 Sketch or import an open vector that defines the exact 
dimensions of your tool's half-profile. This vector is revolved to 
create the tool. 

 



 

ArtCAM 2015 What's New What's New in ArtCAM 2015 • 47  

2 Ensure the vector is selected, then in the Toolpath Operations 

area of the Toolpath panel, click Create Custom Form Tool  

to display the Edit Tool dialog. 

 

The dialog displays the profile of the tool you are creating ( ), 

and contains fields in which to enter details about the tool. 

3 Enter your tool's parameters. For more information about tool 

parameters, see the reference help. 

4 Click OK. The Tool Database dialog is displayed. 

 

Your custom tool is added to the bottom of the tool tree. 

 You can drag the tool to move it to a new location in the 

tool tree if you wish. 
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5 Click OK to close the dialog.  
 

Updating bridges 

 If you are working in ArtCAM Express, the Create Bridges 

option and full bridging functionality is only available with the 
Advanced 2D Machining module. If you do not have this 

module, you can add only one bridge to each vector, and this 

bridge can only be placed on the start point. 

There is a new Update all button on the Tool Settings: Create Bridges 

panel, and on the Profiling, Bevel Carving, Female Inlay, and Male 

Insert toolpath panels.  

 

Click Update all to update any existing bridges on the selected 

vectors with the defined Length, Thickness, and Type values. 
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Importing .dxf files with the 2D Machining Wizard 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

In ArtCAM 2015, the 2D Machining Wizard panel has a new layout, 

and there are two new options, which enable you to choose the .dxf 

file's units.  

Being able to choose the file's units means you can import .dxf files 

that have been saved in inches, but process them in a metric 
ArtCAM model with the 2D Machining Wizard doing the necessary 

scaling. This workflow provides you with more flexibility. For 

example if you work in a field dominated by inches, but prefer to 
work in millimetres, if you get sent .dxf files in inches, you can still 

work with them in millimetres within ArtCAM. 

ArtCAM 2013 ArtCAM 2015 
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2D toolpath shading added to Advanced 2D Machining 
module 

In ArtCAM 2015, ArtCAM Express customers who have the 

Advanced 2D Machining module can now apply shading to toolpath 
previews in the 2D View window. This enables you to preview the 

areas of the material that will be cut by the calculated toolpaths. 

 

 

To turn on shading: 

 Click the solid grey double light bulb icon  beside the 
Toolpaths item in the Project Tree to display a shaded preview of 

all toolpaths in the Project Tree. All the solid light bulb icons turn 
yellow to indicate the toolpath previews are visible in the 2D View 

window. 

 

 Click the solid grey double light bulb icon  beside a toolpath 

group to display a shaded preview of all toolpaths within that 

group. The icon turns yellow to indicate the toolpath previews 
are visible in the 2D View window. The light bulb icon beside the 

Toolpaths item turns half yellow  to indicate that only some 

toolpaths are previewed. 
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 Click the solid grey single light bulb icon  beside a toolpath to 

display a shaded preview of an individual tool's toolpath. The 
icon turns yellow to indicate the toolpath preview is visible in the 
2D View window. The light bulb icons beside the Toolpaths item 

and the toolpath group turn half yellow  to indicate that only 

some toolpaths are previewed. 

 

You can control the colour of the toolpath shading using the Options 

panel. 

1 From the Main Menu bar, select Edit > Options. This displays the 

Options panel. 

2 Click the Drawing Colours control bar to expand its settings. 

3 In the 2D Drawing Colours area, click the Toolpath Simulation 
colour swatch. This displays the Color dialog. 

4 Select a new colour from the Basic colors area, or choose a 
custom colour from the colour matrix window, and click OK. 

5 In the Options panel, click Apply. 
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Defining material dimensions in Express and Insignia 

In ArtCAM 2015, when you create a new model in ArtCAM Express 
or ArtCAM Insignia, the Size For New Model dialog replaces the Setup 

Job Dimensions dialog, so you no longer have to define the material 

thickness or the model's position within the material before creating 
your model. 

 

You must now set the material thickness and the model's position in 
the material using the Material Setup dialog, which matches the 

workflow used by ArtCAM Pro and ArtCAM Jewelsmith. 

You can display the Material Setup dialog in two ways. Either: 

 Click Setup Material in the Toolpath Operations area of the 

Toolpaths panel; or, 

 

 Click the Define Material control bar when creating a toolpath. 
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User interface changes 
ArtCAM 2015 includes the following improvements to the ArtCAM 

user interface: 

 Transform panel (see page 53) — There is an additional way to 

switch between the two Transform panel pages. 

 Set Model Size dialog (see page 54) — The Height In Z field in the 

Set Model Size dialog now defaults to 0. 

 Defining material dimensions in Express and Insignia (see page 52) 

— The Setup Job Dimensions dialog is replaced by the Size For 

New Model dialog in Express and Insignia to bring the workflow in 

line with Pro and Jewelsmith.  

 Resetting reliefs (see page 54) — The Zero and Zero Rest options, 
which were previously located on the Shape Editor panel, are now 

called Zero Inside Vector and Zero Outside Vector, and are found 

on the Relief Editing toolbar. 

 The following panels have a new layout: 

 Tool Settings: Text Tool panel (see page 22). 

 Tool Settings: Two Rail Sweep panel (see page 15). 

 2D Machining Wizard (see page 48). 

 Miscellaneous interface changes (see page 55) — These options 

have the same behaviour, but a new name or location. 
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Transform panel 

In the Transform panel, More options is added to the Relief Clipart 

area. This provides another way for you to quickly switch between 
the two Transform panel pages. 

 
 

Set Model Size dialog 

The Height In Z field in the Set Model Size dialog, which is displayed 

when you select File > New > From Image File, now defaults to 0. If 

you enter in a value, ArtCAM remembers this the next time you 
open this dialog. 
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Resetting reliefs 

 ArtCAM Insignia, ArtCAM Pro, and ArtCAM Jewelsmith only. 

There are the following improvements to the way you access the 

buttons that enable you to reset, or zero, relief: 

 The buttons have a new design and are now located on the Relief 

Editing toolbar, rather than on the Shape Editor panel. 

 

 The buttons are renamed to make their function more clear: 

 Zero is now called Zero Inside Vector .  

 Zero Rest is now called Zero Outside Vector . 

 There are two new keyboard shortcuts, which can help to speed 

up your workflow. 

 Press Ctrl+0 to zero inside a vector. 

 Press Ctrl+Alt+0 to zero outside a vector. 
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Miscellaneous interface changes 

The following options have the same behaviour, but a new name or 

location: 

 In the Edit menu, the Block Copy / Rotate option is now called 

Block and Rotate Copy to make it consistent with the panel.  

 

 The Wrap text around a curve button is no longer available from 

the Design Tools toolbar because this tool is now part of the Tool 

Settings: Text Tool (see page 22) panel. 
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 In the Toolpaths menu, the Simulation submenu is now called 

Relief Simulation. 

 

 The Create Vector Boundary panel is now called Create Boundary 

from Relief to make the button and panel consistent with each 

other. 

 The sculpting tools from the Design Tools toolbar are also 
available from the Reliefs > Sculpt menu. 
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 When running ArtCAM in standard layout mode, the View 

Manipulation toolbar is docked in the top toolbar by default.  
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General enhancements 
There are the following general enhancements in ArtCAM: 

 Importing STL files (see page 59) — By default, ArtCAM now 

identifies and removes duplicate faces when you import STL files. 

 New Express modules (see page 60) — There are four new 

modules available for ArtCAM Express customers: Bevel Carving, 

Fluting, Multi-plate engraving, and Panelling. 

 New Insignia tools (see page 61) — Several tools that were 

previously available only for Pro and Jewelsmith users are now 

available for Insignia users. 

 Licencing information (see page 62) — The type of licence you 

hold is now displayed in the product banner. 
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Importing STL files 

Some STL models have duplicate faces, which can be problematic 

for some operations, such as creating supports for 3D printing. By 

default, ArtCAM now identifies and removes any duplicate faces 
when you import STL files. To disable this process, deselect Remove 

duplicate faces from STL in the File Import area of the Options panel. 
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New Express modules 

There are four new modules available to ArtCAM Express 

customers: 

Bevel Carving — This module enables you to create a toolpath that 

replicates a bevelled look for the vector artwork that you have 
selected. 

Fluting — This module enables you to create and control ramping 

cuts along vectors. 

Multi-plate Engraving — This module enables you to create sheets of 

badges or name-plates, each with its own unique details, using only 
vector artwork to control the shape and layout, a text file (*.txt or 

*.csv) containing the data you want to feature on the plates, and 

vector text to set how and where this data is used. 

Panelling — This module enables you to machine a design larger 

than the bed-size of your router, or larger than the sheets of 

material that are currently available. 
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New Insignia tools 

You can now use the following tools in ArtCAM Insignia: 

Weave Wizard — Use the Weave Wizard to create a woven relief 

using at least two vectors. 

Extrude — Use the Extrude tool to create an extruded relief using at 

least two vectors. 

Spin — Use the Spin tool to create a relief by spinning a vector 

around its start node. You can control the profile using an additional 

two vectors. 

Turn — Use the Turn tool to create a relief by turning a vector about 

an axis drawn between the vectors start and end nodes. 

Offset (Classic) tool clearance strategy — The Offset (Classic) tool 

clearance strategy is now available for Insignia users when creating 
Machine Relief toolpaths. 

Material Setup slider — Use the slider on the Material Setup dialog to 

set the position of the model within the material when creating 

toolpaths. 

Relief Slicer — Use the Relief Slicer to slice a relief and export the 

slices as .rlf, .svg, and .png files. 

For more information about these tools, refer to the Reference Help. 
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Licencing information 

The product banner includes your licence type. 

 

One of the following licence types will be displayed in the product 

banner: 

TIME-LIMITED licence — This licence allows you to use ArtCAM for 

a fixed period of time. When this licence expires, the licence will 

stop working; you will still be entitled to run previously 

maintained versions. 

FULL licence — This licence allows you to use versions of the 

product released prior to your maintenance contract expiry date. 

When your maintenance contract expires, you will not have 
access to future releases. 

ACADEMIC licence — This licence is for use of an academic 

institution. It is time-limited and should not be used for 
commercial purposes. 

DEMONSTRATION licence — This licence allows you to 

demonstrate new products. 

In all cases, the number of remaining licence days will be included if 
the number of days remaining is less than, or equal to 30 days. 

Licencing information is also displayed in the About dialog. 
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